
 

 

 

  

 

Основы использования 
приложения Tableau Desktop 
6.1 
В этом документе вам представлены обучающие материалы для первого знакомства 
по работе с продуктом Tableau Desktop от компании Tableau Software. Описание 
пошаговых инструкции для использования основных возможностей программы, 
изучите содержание для более подробного ознакомления. 

Гаврилов Юрий 
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Подключение к данным 

Первое, что нужно сделать, приступая к работе с Tableau - это подключиться к источнику данных. Выполните 

следующие действия для подключения к простому Excel документу, который поставляется с Tableau и уже 

имеется на вашем компьютере. 

1. Выберите Подключение к данным на 
стартовой странице 

 

2. Выберите тип источника данных. 
Для примера, выберите Microsoft 
Excel и нажмите кнопку ОК. 

 
 

 

3. Настройка соединения.  
Нажмите кнопку Обзор (Browse), чтобы выбрать Sample - Superstore Sales (Excel).xls Документ 
находится в папке документов  «\My Tableau Repository\Datasources». Затем выберите лист Orders и 
нажмите кнопку ОК. 

 

Примечание: Если у вас возникли проблемы с подключением к собственной книге Excel, убедитесь, что данные 

на каждом листе организованы в строках и столбцах должным образом. Чтобы увидеть пример того, как 

организовать данные, откройте файл примера, который поставляется вместе с Tableau. Вы можете найти его в 

папке Мои Документы по адресу: \My Tableau Repository\Datasources\Sample - Superstore Sales (Excel).xls. 

Директория «Tableau Repository» 
находится в папке "Мои 
Документы". 
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Создаи те свои  первыи  View 

После подключения к источнику данных, доступные поля отображаются на левой стороне экрана, в виде 
измерений и мер. Для создания View представлений  просто перетащите необходимое поле на витрину. 

1. Перетащите измерение (Dimension) в 
область Столбцы (Columns).  

Щелкните и перетащите поле "Category" в 
область Столбцы (Columns). 

 

2. Перетащите измерение в область строк 
(Row). 

Перетащите поле "Region" и поместите его в область 
строк (Row) 

 

3. Перетащите значение (Measure) в 
область данных (Text Shelf). 

Нажмите и перетащите продажи (Sales) в область 
данных (Text). 

 

4. Перетащите еще одно измерение 
(dimension) в область строк (Row). 

Перетащите поле Сегмент Клиентов (Customer 
Segment) в область строк (Row). 

Только, что вы создали сводную таблицу продаж по 
регионам и сегменту клиентов. 

5. Визуализация данных. 
Перетащите меру Продажи (Sales) из области Текст 
(Text) в область столбцов (Columns).  

 

6. Используйте область цвет (Color), чтобы 
добавить больше смысла данных.  

Перетащите измерение регион (Region) из окна 
данных и поместите его в область цвета (Color). 

 
 

Посмотрите, что 
еще 
Вы можете 
исследовать 
просто путем 
перетаскивания 
полей и мер. 

Теперь вы 
можете 
найти 
лучшие и 
худшие 
продукты, 
регионов 
и рынка. 
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Обзор Tableau Server 

При первом входе на сервер, вы увидите список представлений (View) и область навигации на левой стороне 

страницы. Найдите минутку, чтобы изучить интерфейс Tableau Server. Основные области, описаны ниже. 

 

А. Зона навигации 
Служит для обзора проектов, рабочих книг и 
представлений. Вы можете использовать быстрые 
ссылки для перехода к общему списку или 
сортировать списки (например, представления, 
упорядоченные по проекту). Если вы вошли как 
Администратор, зона навигации также содержит 
ссылки на Административную часть сервера. 

С. Действия (Actions) 
Меню Действия (Actions) содержит несколько 
команд, которые вы можете применить для 
выбранных элементов в списке. Например, вы 
можете установить разрешения, изменять теги, 
удалить или настроить автоматическое обновление 
для источников данных. Действия зависят от прав 
пользователя и типа лицензии. 

D. Параметры сортировки (Sort Options) 
Сортировка списка по имени, по проектам, по дате  
изменения, и т. д. Вы можете сортировать по 
возрастанию или по убыванию. 

В. Перечень Представлений (View) 
Список представлений показывает все View на 
сервере. Точно так же вы можете просмотреть список 
книг, проектов, источников данных, и так далее. 
Список можно просматривать в виде миниатюр 
или текста. 

Е. Поиск (Search) 
Поиск содержимого на сервере. Вы можете 
использовать ключевые слова, чтобы ограничить 
поиск. Например, поиск по названию: прогнозы 
продаж возвращает только те элементы, имя 
которых содержит слова "продажа" или "Прогноз". 
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Открыть представление (View) 

После перехода в конкретное представление, вы можете взаимодействовать с пред настроенной 

визуализацией в нем. Давайте посмотрим представление «Area Sales Performance» см. картинку ниже. Этот 

пример поставляется вместе с приложением Tableau и доступен в каждой версии. Вы можете 

взаимодействовать с представлением, используя панель инструментов, быстрые фильтры «Quick Filters», 

подсвечивание «highlighting», Акшэн-фильтры (фильтр-действие – Action Filter), между картой, таблицей и 

графиком. Т.е. можно настроить так, что бы при выборе данных в таблице, карта автоматически изменилась 

под выбранные данные.   

 

Например, это представление показывает продажи по сегментам клиентов и почтовому индексу. 

Использование быстрого фильтра слева позволяет исключить определенные сегменты рынка из выборки. 

 

 

  

Интерактивность зависит 
от уровня лицензий и 
разрешений 
пользователя. С уровнем 
лицензии "Interactor" 
(Интэрактор), вы можете 
сортировать, фильтровать, 
просматривать 
выбранные данные и 
многое другое. Уровень 
лицензии "viewer" 
(Вьювер) могут только 
смотреть представление и 
всплывающие подсказки 
на нем. 

Уберите флажок "Corporate", чтобы 

исключить все продажи сегмента 

"Corporate" из просмотра. 
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Администрирование пользователеи  

Как администратор вы несете ответственность за добавление пользователей и назначения им уровня лицензии. 

Войдите в качестве администратора и следуйте дальнейшим инструкциям. 

Раздел администрирования в области навигации содержит инструменты для управления пользователями, 

группами, проектами, лицензированием и многое другое. А сейчас давайте сосредоточимся на странице 

пользователя. Нажмите ссылку пользователи "Users". 

 

После стандартной установки сервера вы увидите всего двух пользователей в списке: Administrator и Tableau 

Software. Далее в столбцах вы увидите тип лицензии присвоенной пользователю, дату последнего входа в 

систему и др. атрибуты. 

 

 

 

 

 

 

 

На старт, Внимание, Марш! 

Теперь вы готовы добавить своих собственных пользователей и распространять лицензии. 

Нажмите на ссылку «Добавить» пользователя (Add User) в нижней части списка, чтобы начать добавлять 

пользователей. Если вы хотите загрузить готовый список пользователей из файла CSV, обратитесь к полному 

руководству. Administrator Guide  

Вы можете изменить любой из 

этих атрибутов, выбрав 

пользователя и затем выбрать 

соответствующее действие на 

панели действий (Actions). 

http://www.tableausoftware.com/currentadmin.php
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Создание Связеи  (Joins) 

Tableau поддерживает реляционные связи таблиц без необходимости создавать табличное представление. 

Следуйте инструкциям ниже, чтобы начать объединение таблиц. 

1. Откройте диалоговое окно Таблицы 
(Tables). 

Меню Данные> Таблицы (Data > Tables). В окне 
нажмите кнопку добавить (Add). 
 

 

 

2. Выберите таблицу для добавления. 
В следующем диалоговом окне выберите таблицы, 
чтобы добавить к существующей схеме данных. 
 

 
 

3. Определить связь (Join). 
Добавьте связь, выбрав вкладку "Join". 
В окне Join, добавить один или несколько связей, 
выбрав поле из исходной таблицы и поля из 
дополнительного источника, укажите оператор для 
связи. Затем нажмите кнопку «Добавить» (Add), для 
сохранения выбранной связи. 
 

 
 

4. Начинайте использовать Tableau. 
Когда вы закончите определение своего 
соединения, нажмите кнопку ОК. Обратите 
внимание, что схема таблиц организована таким 
образом, чтобы вы можно легко определить, где 
какое измерение и измерение находится. 
 

 

 

Примечание: При выборе таблиц для добавления, можно по желанию изменять первоначальное название 

полей и давать им псевдонимы. Кроме этого, вы можете исключить ненужное поле из схемы, для этого следует 

убрать  флажки рядом с названием таблицы на втором этапе. 
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Извлечение данных (Extract) 

Опция «Выгрузка» сохраняет все подмножество исходных данных, которые можно использовать для 

повышения производительности, позволяет модернизировать источник данных в целях обеспечения 

расширенных возможностей, а также выполнять автономный анализа без подключения к сети. Следуйте 

инструкциям ниже, чтобы узнать, как создать экстракт (Выгрузка). 

1. Откройте диалоговое окно извлечения 
данных (Extract Data). 

Выберите Data > Extract. 
 

 
 

2. Добавить фильтр (Add a Filter). 
В диалоговом окне Извлечение данных нажмите 
кнопку «Добавить» (Add), а затем выберите поля для 
фильтра. Используйте диалоговое окно Фильтр, 
чтобы определить значения, которые вы хотите 
включить в экстракт. После завершения нажмите OK. 

 

3. Извлечение и сохранение данных 
В диалоговом окне Извлечение данных нажмите 
кнопку Извлечь. В том же окне выберите папку для 
сохранения экстракта и нажмите кнопку Сохранить 
(Save). 
 

 
Вы можете добавить много разных фильтров как вам 
необходимо. 

4. Использовать экстракт (Use Extract). 
Вы можете легко переключаться между 
использованием экстракта и использованием всех 
исходных данных, выбрав опцию в меню Data > Use 
Extract. 

 
Примечание: Если вы переместите или переименуете 
файл экстракт и откроете документ, связанный с этим 
файлом, вам придется указать новый путь к файлу с 
экстрактом. Вам будет предложено указать новый 
путь перед открытием документа. 
 

Ограничение выгрузки данных (Extract Limiting)  
Вы можете извлечь данные без определения конкретных фильтров, 

используя опцию Лимит (Limiting). В диалоговом окне Извлечение 

данных укажите процент записей от общего числа строк в источнике, 

либо конкретное количество записей. Если вы все же добавили 

какие-либо фильтры, эти фильтры тоже применяются. 

Снимите флаг 

использования 

экстракта в любое 

время в меню Data 

> Use Extract. 
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Агрегированныи  Экстракт (Extract) 

Теперь у вас больше контроля над тем, как ваши экстракты (Выгрузка данных) создаются. В частности, вы 

можете исключить колонки, создать фильтры, чтобы ограничить количество строк, агрегировать данные, 

развернуть даты. Все эти настройки помогут вам сократить размер файла извлечения и увеличить 

производительность. 

1. Скрыть неиспользуемые поля 
Скрытые поля не будут включены в экстракте 
(extract). Вы можете быстро скрыть все поля, которые 
не используются в текущем источнике данных, 
выбрав «Скрыть все неиспользованные поля» (Hide 
All Unused) в меню Данные (Data). 
 

 

2. Выберите Data > Extract (Данные > 
Извлечь) 

Откройте диалоговое окно извлечение данных, 
выбрав Data > Extract. В диалоговом окне, по выбору 
определить один или несколько фильтров, чтобы 
ограничить объем извлекаемых данных. 
 

 
 

3. Агрегировать данные для видимых 
измерений (Aggregate Data) 

После определения каких-либо фильтров, выберите 
опцию «Агрегировать данные» для видимых 
измерений. Это опция агрегирования данных,  
используется по умолчанию. Если экстракт (extract) 
содержит поле формата Даты, можно 
дополнительно развернуть даты до определенного 
уровня для дальнейшего сокращения размера 
извлекаемых данных(extract). 
 

 
 
Щелкните правой кнопкой мыши на меру в окне 
данных (Data) и выберите необходимый уровень 
агрегации. 

4. Нажмите кнопку «Извлечь» (Extract) 
Когда все готово, нажмите кнопку «Извлечь» (Extract) 
и укажите место для извлечения файла (TDE).Экстракт 
содержит только видимые поля, и данные будут 
агрегированы, как вы указали. 
 

 
 
Вы можете в любое время обновить экстракт выбрав 
меню данные > Обновить экстракт (Data > Refresh 
Extract). 

Вы также можете 

щелкнуть правой 

кнопкой мыши на 

одно поле, чтобы 

скрыть его или 

показать. 

Глобальные фильтры 

(Global Filter) будут 

автоматически 

добавлены в качестве 

фильтров на экстракт. 
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Источники данных из буфера обмена  

Легко анализировать данные из большинства настольных приложений. Просто скопируйте и вставьте 

табличные данные в Tableau. Скопированные данные будут автоматически представлены как Источник данных, 

чтобы вы могли сразу приступить к работе. 

1. Скопируйте данных 
Выберете данные в настольном приложений и 
скопируйте его в буфер обмена. 
 

 

2. Вставьте данные в Tableau 
Откройте Tableau Desktop и выберите меню Edit > 
Paste Data. Новый источник данных создастся 
автоматически. 
 

 
 

3. Сохраните источник данных (Data Source) 
Когда вы сохраняете документ, источник данных будет сохранен в папке данных Tableau (Tableau 
Repository\Data Source), которая в свою очередь находится в папке "Мои документы". 
 
 

 
 
 

 

 

  

Tableau 

обрабатывает 

данные из 

буфера с 

разделителями 

"запятая" и 

"Табуляция". 

При сохранении книги в пакетный формат 

(Packaged workbook), источник данных 

сохраняется внутри файла, а не в хранилище. 
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Интеграция данных (Data Integration) 

Объединение данных из нескольких источников данных на одном листе. Окно Данные (Data) включает в себя 

список всех источников данных, к которым вы подключены. Отношения между источниками данных создаются 

автоматически, если совпадают названия полей из разных источников, или вы можете создать связи 

самостоятельно. 

1. Подключитесь к нескольким 
источникам данных 

Выберите Data > Connect to Data и 
настройте подключение, по крайней мере, 
к двум источникам данных. Подключенные 
источники данных показаны в 
раскрывающемся списке в части экрана 
Данные (Data). 

 
Основной и второстепенный источники 
данных различаются цветом. (Основной 
"Синий", второстепенный "Оранжевый"). 

2. Используйте поля из обоих источников данных 
При перетаскивании поля из дополнительного источника 
данных в поле представления (View), Tableau автоматически 
создает связи между источниками данных. Связанные поля 
отмечены специальным значком в окне данных. 

 
В этом представлении (View), бруски диаграммы создаются на 
основе меры "Продажи" (Sales) из основного источника данных 
(Superstore Sales), а линии диаграммы показывают меру плана 
продаж (Sales Plan) из вторичного источника данных. 

3. Создание пользовательских 
связей 

Связи создаются автоматически на основе 
имен полей, однако, вы можете установить 
собственные связи, выбрав меню Data > 
Relationships. 

 

4. Изменение и Определение связей 
В диалоговом окне Связи (Relationships) выберите основной 
источник данных в раскрывающемся писке, в верхней части 
диалогового окна. Затем выберите дополнительный источник 
данных. Все автоматически настроенные связи показаны на 
экране. Для настройки связи вручную нажмите "Custom" и 
нажмите кнопку «Добавить» (Add), укажите связь полей и 
нажмите кнопку "ОК". 
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Иерархии (Hierarchies) 

По умолчанию Tableau автоматически отделяет поля дат как иерархию (hierarchies) поэтому вы можете легко 

раскрыть представление как год, квартал, месяц и т.д. Вы также можете создавать свои собственные 

пользовательские "Иерархии" (hierarchies). Например, у вас есть поля Регион, Город, округ и т.д. Вы можете 

создать иерархию (hierarchy) по этим полям для того, что бы  быстрей перемещаться с одного уровня на другой. 

 

Перетаскивание полей в окне данных 

Создание иерархии осуществляется простым перетаскиванием одного поля на другое в окне данных. После 

этого вы можете перемещать поля, чтобы изменить порядок уровней иерархии. 

 

 

 

 

 
 

Примечание: Вы можете также создавать иерархии, выделив несколько полей в окне данных, щелчку правой 

кнопкой мыши на меню Создать Иерархию (Create Hierarchy). 

  

При перетаскивании элемента иерархии в область представления 

(View), вы можете использовать кнопки плюс и минус (+/-) для 

перемещения между уровнями. 
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Инкрементное извлечение данных 
(Incremental Extracts) 

Когда вы импортируете все или часть данных во внутреннее хранилище данных Tableau (Файл формата .TDE), 

вы создаете экстракт (extract). После создания первоначального экстракта (extract), вы можете установить 

Инкрементное обновление (Incremental Refresh), так что бы импортировались только те записи, которых еще 

нет в уже извлеченных данных, в хранилище. Инкрементное обновление может быть определено по 

указанному значению в соответствующем столбце. Например, вы можете выгружать данные по полю Дата 

(Date), в этом случае в существующее хранилище будут добавляться только новые записи. 

1. Создайте экстракт (Extract) 
Выберите Data > Extract для создания первой 
выгрузки. Вы должны сделать полное извлечение 
данных, прежде чем можно будет настроить 
инкрементное обновление. 
 

 
 

2. Настройте Инкрементное Обновление 
После импорта данных, откройте снова диалоговое 
окно Экстракт (Extract). Выберите флаг 
"Инкрементное Обновление" (Incremental Refresh) и 
выберите столбец, по которому будут определяться 
новые записи. После завершения нажмите кнопку 
"Extract". 
 

 

3. Посмотреть историю Извлечения 
(Extract History) 

Вы можете посмотреть список прошедших 
обновлений со времени первоначальной выгрузки 
данных, нажмите Data > Extract > History. 
 

 
 

4. Добавление данных из файла (Data from 
a File) 

Если у вас есть один регулярно обновляемый файл 
данных, например, CSV или Excel файл, то вы можете 
добавить данные непосредственно из локального 
файла. Выберите меня Data > Extract > Add Data from 
File (Добавить данные из файла). 

 
Названия полей источника данных первоначальной 
загрузки должно совпадать с названиями полей 
добавляемого файла. 
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Название заголовков полеи  (Field Labels) 

Например, у вас есть столбец, который содержит строки для разных категорий продуктов, таких как техника, 

Книжные шкафы и т.д., Вы можете включить опцию "Показать название" (Show\Hide Field Labels for 

Rows/Columns). По умолчанию имена полей отображаются, но вы можете выбрать, чтобы скрыть их. 

1. Показать / скрыть название полей 
Выберите опцию в меню «Table > Field Labels for Columns» или «Field Labels for Rows» 
 

 
 

2. Формат Заголовков Полей 
Щелкните правой кнопкой мыши на названии поля в области представления и выберете опцию Формат 
(Format). В окне Формат (Format) вы можете указать тип шрифтов, теней и многое другое. 
 

 
 

 

Название полей отображается в 

заголовках, и отражают название 

используемых данных в таблице. 
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Выделение цветом - Легенда  
(Color Legend Highlighting) 

Выделение Цветом мощная аналитическая функция, которая позволяет вам сфокусироваться на некоторых 

элементах в представлении (View). При включении опции Выделение цветом, элементы, связанные с 

выбранными данными окрашены цветом, в то время как все остальные элементы показаны серым. 

1. Включите опцию "Выделение цветом" 
Нажмите кнопку «Выделить» (Highlight) в названии 
области Легенды или выберите «Выделить выбранные 
элементы» (Highlight Selected Items) в раскрывающемся 
меню области "Цвет" (Color). 
 

 
 

2. Выбор Элементы в области 
«Легенда» 

Выбранные Элементы будут окрашены цветом, в 
то время как остальные элементы будут серыми. 
 

 
На примере выбраны все продукты, доставленные 
Грузовым транспортом. 

3. Отключение режима Выделения Цветом 
Нажмите кнопку «Выделить» (Highlight) в заголовке окна 
легенды или уберите флаг из раскрывающегося меню 
«Выделите выбранные элементы» (Highlight Selected 
Items). Выделение цветом будет возвращено к 
первоначальному виду. 
 

 
 

4. Назначение цвета, выделяемым 
элементам из палитры 

Если вам нравится, как смотрится выделение 
цветом, то можно сохранить назначенные цвета в 
цветовую палитру. Выберите «Задать Цвет 
выделения в палитру» в раскрывающемся меню 
окна легенды (Assign Highlight Color to Palette). 
 

 
 

 

Выделение цветом будет 

возвращено к 

первоначальному виду. 

Цвета выделения 

будут присвоены 

элементам 
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Дашборды (Dashboards, Панели)  

Дашборд представляет собой набор из нескольких представлений (View)  на одном листе, где вы можете 

сравнивать и наблюдать различные данные одновременно. Например, вместо того, чтобы пролистывать 

множество разных представлений (View), которые вы рассматриваете ежедневно, вы можете создать Дашборд, 

который показывает их все сразу на одном экране. 

1. Создайте новый Дашборд (Dashboard) 
В документе, который содержит несколько листов, 
Выберите меню Edit> New Dashboard. 
 

 

2. Добавить Представление (View). 
Перетащите листы из окна на панели в левой части 
книги на Дашборд (Dashboard). Вы можете поместить 
множество представлений (View) на один Дашборд. 
 

 
При перетаскивании представления (View) 
отображается черная полоса, сигнализирующая о 
будущем расположении представления. Отпустите 
левую кнопку мыши и представление (View) займет 
выбранную вами позицию. 

3. Показать Легенду и Быстрые фильтры 
(Legend, Quick Filter). 

Выберите Представление на Дашборде. В 
раскрывающемся меню выберите необходимые 
пункты, которые вы хотите отобразить. 

 
Используйте Меню Дашборда, чтобы отобразить 
«Заголовки»(Titles), Название Представлений 
(captions), Легенду и Фильтры (legends, filters). 

4. Перестановка частей Дашборда 
(Dashboard) 

Выберите Представление, которое вы хотите 
переместить. Затем нажмите и перетащите 
Представление, удерживая левой кнопкой мышки, за 
синею рамку в верхней части Представления, на новое 
место. 

 
Настройка размера Дашборда (Dashboard Size) 

При создании Дашборда, который будут рассматриваться другие 

пользователи, важно указать необходимый размер экрана. Вы можете 

указать фиксированный размер или минимальный. Размер Дашборда 

необходимо указывать для того, чтобы у каждого пользователь он 

выглядел на экране одинаково. Установите размер, нажав кнопку 

«Изменить» (Edit) в области «Размер» (Size) на экране Дашборда.  

Также можно щелкнуть 

правой кнопкой мыши на 

листе вкладки в нижней 

части книги и выбрать 

«Новый Дашборд» (New 

Dashboard) 
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Быстрая Сортировка (One-Click Sort) 

Два кнопки быстрой сортировки расположены на панели инструментов. Они помогут сортировать выделенные 

данные в порядке возрастания или убывания. 

1. Выберите Поле (Field) или элемент 
(Members) для Сортировки. 

Выберите один или более элементов или все Поле, 
которое вы хотите отсортировать. Вы можете выбрать 
Заголовки на Представлении или Названия полей, 
расположенных чуть выше,  на полке, в области 
Колонок и Строк (Columns, Rows) 
 

 
 
В этом случае продукция будет сортироваться на 
основе значения брутто прибыль (gross profit) в 
сегменте потребительского рынка (consumer market). 

2. Нажмите Сортировка (Sort) на панели 
инструментов. 

Выберите одну из команд сортировки на панели 
инструментов. Вы можете сортировать в порядке 
возрастания или убывания. 
 
 

 
 
При наведении курсора на кнопку появляется 
всплывающая подсказка, которая описывает тип 
сортировки. 

3. Посмотрите на результат. 
Ручная сортировка выполнена, а Сортированное Поле 
отмечено жирным шрифтом. 
 

 
Продукты отсортированы в порядке возрастания по 
значению Валовая прибыль по сегментам 
потребительского рынка. 

4. Изменить Сортировку. 
Вы можете редактировать тип сортировки, выбрав 
опцию «Сортировка» (Sort) из раскрывающегося 
«Меню Поля» (field’s menu). Измените, порядок 
сортировки вручную или укажите принцип 
автоматической сортировки. 
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Группировка и Группы (Groups) 

Иногда вам требуется сгруппировать несколько элементов измерения (dimension) по категориям, которых еще 

не существуют в ваших данных. Например, когда вы работаете со списком клиентов, вы можете сгруппировать 

их по категориям, часть прибыльных клиентов объединить в группу VIP, со средним доходом в категорию 

"Постоянные клиенты" и т.д. 

1. Выбор элементов группы. 
Выберите один или несколько элементов, которые вы 
хотите объединить в группу. 
 

 

2. Нажмите кнопку "Сгруппировать" 
(Group)  

Кнопка «Группировка» расположена на панели 
инструментов.  
 

 
 

3. Изменить Название Группы. 
Щелкните правой кнопкой мыши на созданной группе 
в окне данных и выберите «Изменить» (Edit). В 
появившемся окне введите новое имя группы или 
нажмите кнопку «Переименовать» (Rename). 
 

 

4. Добавление и удаление элементов 
группы. 

В диалоговом окне «Редактирование Группы» (Edit 
Group), добавьте или удалите элементы с помощью 
перетаскивания выделенных элементов в списке.  
 

 
Найти Элементы  

Если вы работаете с измерением (dimension), которое имеет много 

элементов, используйте команду поиск для поиска, что бы найти 

элементы по соответствующим критериям. Например, вы можете 

найти все элементы, которые содержат определенный символ в 

названии.  

Элементы 

сгруппированы в одну 

группу. Созданная 

группа отображается в 

окне Данные (Data) 



 

20 

Фоновые изображения (Background Image) 

Фоновые изображения создаются, чтобы добавить больше смысла вашим данным. Чаще всего фоновое 

изображений используется, что бы совместить информацию и географическую карту, используя данные 

широты и долготы. 

1. Откройте диалоговое окно Фоновые 
Изображения (Background Images). 

Выберите меню Данные > фоновые изображения 
(Data > Background Images). В диалоговом окна 
нажмите кнопку «Добавить» (Add). 
 

 

2. Определение координат для Фонового 
Изображения (Background Image). 

Нажмите кнопку Обзор (Browse), чтобы выбрать 
изображение. Далее, для того, чтобы карта 
изображения соответствующих координатной 
системе, выберите Поля, которые соответствуют 
значению осей X и Y. 

 
При добавлении изображения карты, координаты, 
как правило, используются поля широты и долготы. 
Укажите верхние и нижние границы для каждой оси 
изображения. 

3. Укажите условия Отображения / 
Скрытия 

Критерии используются, чтобы не отображать 
изображение на каждом листе рабочего документа. 
На вкладке Параметры (Options) нажмите кнопку 
"Добавить" (Add). Выберите Поле (field) на котором 
будет основан критерий, а затем выберите 
значение(я). 

 
Изображение будет отображаться всякий раз, когда 
выбранное Поле равно заданному значению. 
Например, отобразить карту первого этажа, когда 
выбран первый этаж. 

4. Включение и отключение изображений 
Вы можете добавить несколько изображений к 
книге, Вы также можете использовать несколько 
изображений для определенных набор листов. 
Используйте флажки в Диалоговое окно Фоновые 
Изображения (Background Images), чтобы отключить 
изображение для каждого листа. 

  
Функция отключение 
изображений полезна, 
когда у вас есть карта 
всей территории России 
в одном Представлении 
(view) и более 
подробные карты 
отдельных регионов в 
других Представлениях 
(view). 

Блокировка Оси 
Иногда вам потребуется блокировка осей в вашем Представлении (View). 
Что бы изображение отображалось в нужном виде, вы можете заблокировать 

Используйте опцию "Фокус" на 

навигационной панели инструментов 

для блокировки осей в Представлении. 
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оси координат благодаря использованию функции «Фокус» (Focus), расположенной на навигационной панели 
инструментов, или дважды щелкнув на оси и указанию фиксированного диапазона.  

Линии Трендов (Trend Lines) 

Линии трендов хорошо подходят для отображения тенденций в существующих данных или прогнозов будущих 

данных в вашем Представлении. Следуйте инструкциям ниже, чтобы узнать, как добавить линии тренда для 

вашего Представления. 

1. Включите Линии Тренда 
Выберите меню Analysis > Trend Lines. 
 

  
Этот шаг позволяет 
добавить линейный тренд 
для каждого поля и для 
каждого цвета в 
представлении. Вы 
можете изменить тип 
модели и исключить поля 
и факторы в модели 
линии тренда в 
диалоговом окне 
Параметры (Options) 
(перейдите к шагу два). 

2. Выбор типа Тренда 
При желании, отредактируйте линии тренда, 
используя опцию Параметры линии тренда (Options). 
Выберите меню Analysis > Edit Trend Lines. Затем 
выберите один из типов. 
 

 

3. Исключение полей из модели.  
Снимите выделение полей, которые вы не хотите 
включать в качестве факторов в модели тренда. 
Например, на Представлении квартальных продаж 
для трех различных продуктов в течение четырех 
лет, вы хотите отобразить общую тенденцию 
продаж, а не различные линии для каждого 
продукта. В этом случае, вы должны исключить поле 
(field) продукты (products) из факторов. 

  
 
 
 
 

4. Укажите дополнительные параметры.  
Укажите, в каком случае отображать линию тренда для 
каждого цвета. Если вы используете цветовую 
кодировку на вашем Представлении, вы можете 
использовать эту опцию, чтобы добавить одну общую 
линию тренда.  
 

 
Вы также можете выбрать, что бы ось у стремилась к 
пересечению в нулевой точке.  

 

Примечание: После добавления линии тренда, вы можете использовать  функцию "Описание" (Describe Trend 

Lines Model) для отображения статистики по линии тренда. Например, вы можете увидеть формулу расчета 

линии тренда и значения. Чтобы просмотреть описание одной линии тренда, нажмите правой кнопкой мыши 

Уберите флаг с 

полей, которые 

не хотите 

включать в 

модель линии 

тренда. 
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на линии тренда и выберите "Описание линии тренда" (Describe Trend Line). Для просмотра полного описания 

модели тренда выберите меню  Analysis > Describe Trend Model. 
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Веб карты - Web Map Service 

В дополнение к встроенной онлайн и оффлайн карте Tableau, вы можете подключиться к Web Map Service. WMS 

— протокол для выдачи географически привязанных изображений через Интернет. Когда вы подключаетесь к 

серверу WMS, настройки сохраняются внутри книги. Вы можете поделиться уже настроенными серверами WMS 

с другими пользователями Tableau, экспортируя настроенный список серверов WMS в виде файла TMS. 

1. Выберите источник карт WMS 
Откройте меню Data > Background Maps > WMS 
Server. 
 

 

2. Добавьте подключение к серверу карт WMS 
Нажмите кнопку "Добавить" (Add), чтобы ввести ссылку 
(URL) на сервер карт WMS, который вы хотите 
использовать. Вы также можете добавить ранее 
сохраненные соединения, нажав кнопку Импорт  (Import) 
и выбрав TMS файл. 
 

 
 

3. Нажмите кнопку "ОК", чтобы 
загрузить карту. 

 

 
Просто дважды щелкните на Географическом 
поле в области данных для построения карты в 
Представлении. 
 

4. Экспорт подключений 
Иногда вам может потребоваться поделиться связями 
с другими пользователями. Экспортируйте подключения, 
выбрав сервер в диалоговом окне подключений WMS 
серверов и нажав кнопку 
Экспорт (Export). Соединение сохраняется в файл тапа 
.TMS, который Вы можете отправить другим 
пользователям. 
 

 

Настройка Источника Карт по умолчанию (Default Map Source) 

По умолчанию Tableau будет использовать Интернет карты для всех географических представлений. Вы можете 

настроить свой сервер WMS по умолчанию, добавив его в документ и выбрав меню Data > Background Maps > 

Set as Default 
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Картография (Mapping) 

Очень легко наложить данных на динамическую карту без необходимости, указывать широту и долготу для 

своего собственного изображения карты. При подключении к источнику данных, Tableau автоматически 

определяет поля, которые подходят для отображения на карте, такие как штаты, коды городов, и почтовые 

индексы. Вы можете использовать эти географические поля, чтобы начать анализировать ваши данные на 

карте. 

1. Назначение Географической Роли 
(Geographic Roles) для Поля (fields) 

Tableau автоматически определяет географические 
поля, такие как штаты, страны, почтовый индекс и т. 

д.  
 
 
Вы также можете 
указать вручную, 
что поле 

содержит 
географическую 

информацию, 
щелкнув правой 
кнопкой мыши 
Поле (Field) в окне 
Данные (Data) и 
выбрав меню 

"Географическое 
роль" (Geographic Role). 

2. Выберите Географические поля 
(Geographic Fields) 

Выберите одно или несколько географических полей 
в окне данных и нажмите кнопку «Show Me!» на 
панели инструментов. 

 

3. Выбор типа карты Представления 
В диалоговом окне «Show Me!» выберите тип карты 
и щелкните OK. 

  
Tableau автоматически отобразит ваши данные на 
карте 

4. Параметры карты (Map Options) 
Меню Параметры карты позволяет определять 
различные характеристики карты. Откройте панель 

параметров 
карты, выбрав 
View > Other 
Cards > Map 
Options. 
 
 
 
 
 

Вы можете показать Границы и название, 
регулировать уровень размытия. Вы также можете 
наложить слой данных с переписью населения или 
доходом на душу населения. 

Редактирование местоположений (Editing Locations) 

Иногда Tableau не распознает положение на карте ваших данных. Например, поле, содержащее названий 
городов, возможно, содержит сокращения  вместо "Санкт-Петербург" у вас "Петербург". Вы можете 
редактировать расположение, присваивая каждому значению верное расположение,  щелкнув правой кнопкой 
мыши на поле в окне данных и выбрав меню Geographic Role > Edit Location. Кроме того, некоторые 
географические названия могут существовать в нескольких странах и государствах. Вы можете установить 
значение по умолчанию, чтобы обеспечить более точное расположения ваших данных на карте и правильное 
их сопоставление. Выберите меню Data > Set Default Location. 
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Объекты Дашборда 

Дашборд это тип листа, где вы можете объединить несколько представлений данных на одном экране. В 

дополнение к представлениям Tableau можно добавлять изображения, пользовательские текстовые блоки, 

заголовки, пустые области, и даже внешние веб-страницы. 

Добавление объектов 

Доступные объекты перечислены в нижней части панели окна. Выберите необходимый тип объекта и 

перетащите его на Дашборд. 

 

Заголовок (Title) 
Заголовок объекта позволяет добавлять название, 
которое описывает содержание  Дашборда. Вы 
можете разместить название в любом месте 
Дашборда. По умолчанию, название соответствует 
названию листа. Измените название, щелкнув 
дважды на нем. Вы также можете отформатировать 
название, выбрав меню Format > Dashboard. 

Текстовый объект (Text) 
Этот объекта позволяет добавить текстовые блоки на 
Дашборд. Это необходимо для добавления 
названий, описания, или информацию об авторских 
правах. Текстовые объекты автоматически 
масштабируются, чтобы лучше всего соответствовать 
свободному месту,  где вы его поместили на 
Дашборд. Однако, вы также можете изменить 
размер текстового объекта вручную, перетаскивая 
края текстового объекта. 

Изображение (Image) 
Вы можете добавить статические файлы 
изображений на Дашборд. Например, вы можете 
добавить логотип или описывающие диаграммы. При 
добавлении объекта изображение  вам будет 
предложено выбрать изображение с диска вашего 
компьютера, но Вы также можете ввести URL для 
изображения, размещенного онлайн. 

Веб-страница (Web Page) 
Объект веб-страницы позволяет вставлять любые 
веб-страницы на Дашборд, таким образом, Вы 
можете комбинировать Представления в Tableau с 
информацией из других приложений. Объект веб-
страницы особенно удобны, когда у вас есть 
гиперссылки настроенные в меню Data > Hyperlinks 
command. Если ваше Представление имеет 
гиперссылки на веб-страницы, вы можете отобразить 
эти страницы на Дашборде путем добавления 
объектов веб-страниц "Web Page Object". 
Обновлённая веб-страница автоматически откроется 
на вашем Дашборде, без необходимости открывать 

Свободная область (Blank) 
Этот объект позволяет добавлять пустые области на 
ваш Дашборд, таким образом, Вы можете создать 
макет только справа. Измените размер пустого 
объект, перетащив его за края области. 

Гиперссылки, которые бы добавили, 

обновляются автоматически 

Добавите изображения, 

такие как логотип или 

диаграммы 

Добавление пользовательские текстовые блоки. 

Например, можно добавить информацию об 

авторских правах. 
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Браузер. При добавлении веб-страницы (Web Page 
Object) вас попросят указать URL-адрес. 
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Сортировка Листов & Диафильм 

Вы можете перемещать и организовать листы, в вашем документе, используя, либо сортировщик листов 

(страница с миниатюрами картинками каждого листа), либо режим «Диафильм» для отображения эскизов 

листов в нижней части книги. 

Использование функции сортировки листов 
Возможность сортировки реализована на 
отдельной странице, которая показывает 
миниатюры изображение для каждого листа в 
книге. На странице сортировки вы можете 
изменить порядок, дублировать некоторые 
листы, добавлять и удалять.  
 

Вы можете посмотреть лист сортировки в любое 
время, выбрав среднею вкладку в верхнем 
правом углу экрана. 
 
На листе сортировки вы можете перетаскивать 
листы, чтобы изменить их порядок. Щелкните 
правой кнопкой мыши на листе, чтобы  удалить, 
копировать, и т.п. Дважды щелкните на 
миниатюру, и вы перейдете к ней в стандартном 
режиме просмотра. 
 

Использование режима "Диафильм"(Filmstrip) 
По умолчанию листы представлены в виде вкладок в нижней части книги. Вы можете переключаться между 
режимами отображения листов в виде вкладок или эскизов. 

 
 

  

Эскизы отображаются, после того как вы открыли 

Представление (View) или обновили все эскизы. 

Щелкните правой кнопкой мыши на странице 

сортировки или на ленте эскизов (Filmstrip) и выберите 

Обновить все эскизы (Refresh All Thumbnails). 

Нажмите кнопку в правом 

нижнем углу книги для 

переключения между 

вкладками и эскизами. 
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Относительные Фильтры Даты (Relative 
Date Filters) 

Создайте относительный фильтр данных, который фильтрует ваши данные относительно периода и времени , 

когда вы открываете ваше Представление. Например, вы можете создать динамический фильтр, чтобы 

показывать данные только этой недели, с начала года, последние несколько дней, и так далее. Относительные 

фильтр периода помогает сократить трудозатраты на время обновления данных в вашем Представлении и 

помогает сделать удобный выбор периодов, чтобы мы могли быстрее опубликовать ваш документ. 

1. Перетащите поле даты в область панели 
фильтра (Filter Shelf) 

Перетащите поля и выберите "Дата текущего 
момента" (Relative to Now) из диалогового окна 
фильтра данных (Filter Field).  
 

 

2. Выберите тип измерения времени 
Выберите единицу времени, которую вы хотите 
использовать для отбора. Например, чтобы 
фильтровать только последние три недели, 
выберите Недели (Weeks). 
 

 
 

3. Определение Периода (Date Period) 
Выберите опцию справа и определите дату 
период. Выберите один из представленных вариантов, 
включая текущий период, предыдущий, следующий. 
После завершения выбора нажмите «OK».  
 
 

 

4. Периоды включают текущие единицы 
времени.  

Например, при выборе последних 2х кварталов в 
выборку данных будет включен частично текущий 
квартал и  полностью предыдущий. Используйте 
предварительный просмотр в верхнем углу, чтобы 
проверить свои настройки. 
 

 
 

  

Относительные Фильтры 

Даты (Relative Date Filters) 

доступны в виде быстрых 

фильтров тоже (quick filters). 
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Автоматическая Подсветка (Highlight 
Actions) 

Выделите связанные данные в различных Представлениях, основанные с вашем выбором в текущем 

Представлении (View). Автоматической Подсветкой удобно пользоваться на Дашборде, где вы можете создать 

насыщенное визуальными эффектами Представление (View). 

1. Включить Подсветку (Highlight) 
Включите подсветку используя кнопку 
"Подстветка" (Highlight) на панели инструментов. 
В меню выберите Все поля (All Fields) или 
конкретные поля, чтобы выделить только их. 

 

2. Измените Автоматическую Подсветку 
(Highlight Action) 

Выберите меню Edit > Actions, чтобы открыть диалоговое 
окно "Действия" (Actions). Затем выберите действие и 
нажмите кнопку «Изменить» (Edit).  

 
Любое созданные "Действия" (Action) отображаются в 
окне "Действия" (Actions). Вы можете добавить Фильтр, 
Подсветку или Переход по ссылке URL с заданными 
параметрами. 

3. Укажите параметры Действий (Action 
Settings) 

В диалоговом окне Редактирование Действия 
выберите Основной лист, Целевой лист и поля для 
подсветки. Вы также можете выбрать режим 
запуска Действия, например, когда вы наводите 
курсор мыши, по левому щелчку мыши или по 
правому щелчку мыши на данных основного 
листа. После завершения нажмите OK. 

Будьте 
внимательны 
и задайте 
подходящее 

4. Проверьте работу созданного Действия 
Наведите мышь, Щелкните или щелкните правой 
кнопкой мыши на исходном листе, что бы связанные 
данные были выделены на целевых листах. 
 
 

 
 
Выборка в основном листе подсвечивает данные во всех 
связанных листах. 
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имя создаваемому Действию. 
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Фильтр по Деи ствию (Filter Actions)  

Функция ранее известная как ссылки между листами, эта функция позволяет фильтровать ваши данные на 

целевых листа после наступления выбранного события, например, Наведение курсора мышки, Щелчок мышки 

или всплывающее меню. Этот тип действий хорошо подходит, когда вы создаете аналитический сценарий, в 

котором задействована вся рабочая книга или для Дашборда, который позволяет фокусироваться с основного 

Представления до детальной информации автоматический и на одном экране. 

1. Выберите Представление, которое 
хотите использовать в качестве фильтра  

На Дашборде выберите Представление, а затем в 
раскрывающемся меню выберите "Использовать как 
Фильтр" (Use as Filter). 

 
Фильтр-Действие создано. Теперь, когда вы 
выбираете данные на основном  Представлении, 
другая его часть будет меняться в соответствии с 
вашей выборкой. 

2. Определите Параметры Действия 
(Action) 

Выберите Edit > Actions, чтобы открыть диалоговое 
окно "Действия". Затем выберите действие и нажмите 
кнопку Изменить (Edit). 

 
Любое «Действие» (Action), которое вы создаете, 
отображается в диалоговом окне «Действия». Вы 
можете добавить Действие-Фильтр (Filter-Action), 
Действие-Подсветка (Highlight-Action) или URL-
Действие (URL-Action). 

3. Укажите параметры Действия (Action 
Settings) 

Диалоговом окне «Редактирование Фильтр-
Действия» (Edit Filter Action) укажите  Основной лист 
(source sheets), Целевой лист (target sheets), и Поля 
(fields) для фильтрации. Вы также можете выбрать 
режим запуска действия при наведении курсора, 
выбора щелчком или щелчком правой кнопкой 
мыши. После завершения нажмите OK. 
 

Выберите точно и 
отмените опцию, что 

необходимо 
выполнить с 
фильтром, если вы 
отмените ваше 
действие на исходном 
листе. Выберите 
точно и отмените 
опцию, что 

необходимо 
выполнить с 
фильтром, если вы 

отмените ваше действие на исходном листе. 

4. Проверьте работу вашего «Фильтр-
Действие» 

Наведите мышь, Щелкните или Щелкните правой 
кнопкой мыши на основном Представлении и следите 
за целевыми Представлениями, они должны 
отобразить только соответствующую вашей выборке 
информацию. 

 
Выберите Запад (West) на Представлении сверху и 
остальные области изменят данные в соответствии 
вашей выборки и покажут информацию только о 
продажах для западного региона. 
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Второстепенная Ось (Axis) 

В дополнение к объединению нескольких мер на одной оси, вы можете добавить вторую ось так, чтобы вы 

могли более наглядно сравнить меры различного масштаба. 

1. Перетащите Меру на Представление (View) 
Далее, перетащите Поле (Field) из окна данных на Представление (View). 

 

2. Добавьте вторую меру на Представление 
Перетащите вторую меру на Представление, но на этот раз перетащите её в крайнее правое положение на 
Представлении. Пунктирная линия покажет вам верное место расположения меры, при наведении мыши на 
правую сторону представления. 

 

3. Удаление второстепенной оси 
В любое время вы можете удалить вспомогательную ось, убрав флажок в раскрывающемся меню Поля 
(Secondary Axis). 

 

При добавлении меры или Поля на 

Представление, создаются оси. 

При желании, вы также можете 

добавить на Представление (View) еще 

одно Поле вместо меры. После 

добавления нажмите кнопку «Show 

Me!» (Покажи мне), расположенную на 

панели инструментов. 

Вы можете отредактировать каждую оси в 

отдельности, щелкнув правой кнопкой мыши на 

одну из осей и выбрав Изменить (Edit). Там можно 

указать масштаб, делений, название, и многое 

другое. 
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Режимы Быстрых фильтров (Quick Filter) 

Для создания фильтра на Измерение (dimension), выберите один из пяти режимов быстрой фильтрации, 

который наилучшим образом соответствует вашим данным и тому каким он должен быть представлен внешне. 

Вы можете показать несколько элементов в списке (Multiple Value), режим с одним единственным значением 

для выбора (Single Value), компактный список (Compact), слайдер (Slider) или универсальный (Wildcard). 

1. Включите Быстрый фильтр (Quick Filter) 
Щелкните правой кнопкой мыши на Поле и выберите "Показать Быстрый фильтр" (Show Quick Filter). 

 

2. Выберите режим Быстрого фильтра (Quick Filter) 
В меню быстрого фильтра выберите один из следующих пяти режимов: 

Multiple Value List 
Позволяет выбирать 
несколько значения 
одновременно 

 

Single Value List 
Позволяет выбрать 
любое одно значение 
из списка 

 

Compact List 
Позволяет выбрать одно 
значение из 
раскрывающего списка 

Slider 
Позволяет выбрать 
значения, передвигая 
ползунок от одного к 
другому. 

 

Wildcard Match 
Позволяет выбрать 
значения, содержащие 
указанные символы 
 

 

3. Опция Быстрого фильтра - Поиск значений (Search Quick Filter Values) 
Все режимы быстрых фильтров, кроме универсального (Wildcard), позволяют искать необходимые вам 
значения. Для поиска значений быстрого фильтра  нажмите кнопку «Поиск» (Search) в области заголовка 
быстрого фильтра. Затем введите значение, которое вы хотите найти. 
 

 

Вы можете включать быстрые фильтры (quick filter) для 

любого Поля (Field), даже если вы его не перенесли на 

представление, но оно имеется в ваших данных. 

Совпавшие результаты отображают ниже в окне 

поиска, где вы можете выбрать необходимое 

значение или отменить выбор. 

 

Используйте функцию "Все" (All) она дает вам 

возможность быстро выбрать или отменить все 

значения из списка. 
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Относительная Линия (Reference Lines) 

Нарисуйте линию, которая отображает определенное значение благодаря Относительной Линии. Добавьте 

константу или вычисляемое значение, используя любую меру в Представлении. Например, в Представлении 

региональных продаж вы можете добавить Относительную Линию (Reference Lines), показывающую среднюю 

прибыль для этих регионов. 

1. Щелкните правой кнопкой мыши и 
Добавьте Относительную Линию 

Щелкните правой кнопкой мыши на оси и выберите 
пункт "Добавить Относительную Линию" (Add 
Reference Line) 

 
Отредактируйте Относительную линию позже, 
щелкнув правой кнопкой мыши на оси, и выберите 
меню "Edit Reference Line". 

2. Выберите Периметр для построения 
Линии 

Определите место для отображения вашей линии: На 
всей таблице, Только для одной области, только для 
ячеек 

 

3. Укажите, где провести Линию 
Выберите значение, на которое вы хотите сослаться. 
Вы можете выбрать вычисляемое значение, такое 
как среднее, минимальное и максимальное или 
выбрать константу, введя конкретное значение. 
Вычисленные значения могут быть основаны на 
любом измерении, используемом в Представлении. 

 
Перетащите меры на панель области уровня 
детализации (Level of Detail), чтобы сделать их 
доступными в качестве справочных линий. 

4. Определите Формат линии 
Задайте параметры форматирования, такие как стиль 
линии и цвет. Кроме этого, вы можете выбрать оттенок 
фона, добавив параметр "Заполнить вверх" или 
"Заполнить вниз" (Fill Above, Fill Below). 
 
 

 

 



 

35 

Относительная Полоса (Reference Bands) 

Отметьте область Представления между двумя постоянными или вычисляемыми значениями, используя 

любую меру вашего Представления. Например, в Представлении, которое показывает историю изменения 

температуры в течение долгого времени, вы можете добавить «Относительную Полосу» указывающую 

идеальный диапазон температур. 

1. Щелкните правой кнопкой мыши и 
выберите «Добавить Относительную 
Линию» (Add Reference Line) 

В диалоговом окне "Относительной Линии" (Reference 
Line), выберите "Полоса" (Band). 
 

 
 

Вы можете отредактировать параметры 
"Относительной Линии" (Reference Line), щелкнув 
правой кнопкой мыши на оси, и выбрав «Изменить 
Относительную Линию» (Edit Reference Line) 

2. Укажите диапазон значений (From, 
To) 

Используйте выпадающий список значений для 
указания типа Вычисляемое, Постоянное значение 
или как диапазон значений. 
 

 
 

Перетащите меры на панель детализации (Level of 
Detail) для того, чтобы сделать их доступными при 
параметрировании «Относительной Ленты» 
(Reference Bands) 

3. Формат Ленты (Band) 
Задайте параметры форматирования, такие как стиль 
линий, цвет, или заливку цветом. 
 

 

4. Измените Относительную Ленту 
(Reference Band) 

Внесение изменений в параметры Относительной 
Ленты осуществляются путем нажатия правой 
кнопки мыши на оси и выбора меню «Edit 
Reference Line» 
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Подпись Значении  (Mark Labels) 

Обратите внимание на конкретные значения, подписав значения на вашем Представлении. Подпись Значений 

отображается рядом с каждой точкой данных на вашем Представлении. Вы можете отобразить подпись 

значений для всех точек, только выбранные или выделенные значения, минимальные и максимальные 

значения, или просто на окончании линий. 

1. Нажмите кнопку на панели 
инструментов Показать 
Подпись Значений (Show 
Mark Labels).  

Вы также можете также включить показ подписей 
значений, открыв всплывающее меню "Labels" на 
панели "Marks" 

 

2. Укажите параметры шрифта 
Используйте параметры Шрифта для указания: Типа  
шрифта, размера и Цвета. 

 

3. Укажите, что следует показывать в 
подписи 

Используйте меню "Mark Labels" для указания, какие 
значения отмечать. Например, вы можете 
маркировать только минимальный и максимальный 
значения или только выбранные. 

 

4. Уточните параметры Подписей 
После определения общих параметров Подписи вы 
можете, свою очередь, включить\ выключить подписи 
для отдельных элементов. Щелкните правой кнопкой 
мыши элемент и выберите подменю "Mark 
Labels" 

 
 

Эти опция переопределяют настройки, указанные в 
окне Формат (Format). 

 

  

Если установлено 

значение 

Автоматически, 

Подписи будут 

показаны 

автоматически в 

зависимости от 

того, что 

находится в 

области «Text» на 

панели «Marks». 
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График Пуля (Bullet Graphs) 

График Пуля один из типов гистограммы разработан для замены прошлых версий. График Пуля, как правило, 

используется для сравнения основной меры с одного или несколькими другими мерами в контексте диапазона 

качественных показателей производительности, таких как низкий, удовлетворительный и хороший. Например, 

ниже приведен один пример графика Пуля, который показывает реальные продажи по сравнению с тем, было 

прогнозировано. 

 

1. Выберите две Меры для сравнения 
Удерживая клавишу Ctrl на клавиатуре, выберите 
две меры в окне данных. 

 

2. Нажмите кнопку Show Me! на панели 
инструментов 

Выберите тип графика Пуля (Bullet Graph) 

 
Существует два типа добавляемой относительной 
линии: первый для указания целевого значения, а 
другой для распределения оттенков, чтобы показать 
производительность. 

3. Поменять местами Поля значений 
относительной Линии 

Иногда вам может понадобиться заменить 
относительные линий поля. Например, фактические 
продажи отображается как Относительная линия 
вместо основного блока. Выберите "Поменять 
местами Поля" (Swap Reference Line Fields), щелкнув 
правой кнопкой мыши на оси. 

 

4. Отредактируйте Относительные Линии 
(Reference Line) 

Щелкните правой кнопкой мыши на оси в 
Представлении и выберите Изменить Относительные 
Линии (Edit Reference Line). Затем выберите одну, 
которую ходите изменить и нажните "Изменить" 
(Edit). Вы можете задать новые относительные 
значения, а также параметры форматирования. 

 

Добавить 

меры на 

панель "Level 

of Detail ", 

чтобы 

сделать их 

доступными в 

качестве 

целевого 

значения. 
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Комбинированные Диаграммы 
(Combination Charts) 

Комбинированные Диаграммы могут показывать сразу несколько типов данных разным способом в одном 

Представлении (View). Например, вы можете показать продажи по регионам брусками и отобразить линию,  

показывающую среднюю прибыль для каждого региона благодаря одной диаграмме. Вы можете также 

использовать сочетание диаграмм, чтобы показать несколько уровней детализации на том же Представлении. 

Например, вы можете иметь график с отдельными линиями, показывающими средние продажи по времени 

для каждого потребительского сегмента и вы можете иметь другую линию, которая показывает общий средний 

уровень продаж всех сегментов рынка. 

1. Настройка тип Меток 
Щелкните правой кнопкой мыши на меру на 
панели строк или столбцов и выберите в меню 
"Настройка Меток" (Customize Marks). Затем 
выберите тип меток. 

 

2. Многоуровневый Режим (Layer Multiple 
Panes) 

Щелкните правой кнопкой мыши на меру на панели 
строк или столбцов и выберите опцию (Dual Axis). Теперь 
две оси доступны в представлении. 

 

3. Переключение между областями 
(Switch Between Panes) 

Используйте выпадающее меню в правом верхнем 
углу Панели "Marks" для переключения между 
слоями. Для каждой слоя можно изменять тип 
знака, цвет, форму, размер и т.д. 

 

4. Синхронизация Осей (Synchronize the Axes) 
Щелкните правой кнопкой мыши на вспомогательную 
ось в представлении и выберите "Синхронизировать 
Оси" (Synchronize Axes)  для автоматического 
масштабирования двух осей на одном экране.  
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Фильтрация больших Измерении  

Когда вы работаете с большими измерениями, изменяя настройки фильтра, иногда может занять длительное 

время. Ниже приведены некоторые советы для фильтрации больших объемов данных, используя некоторые 

новые функций версии 6.0.  

Пропустить длительные запросы (Skip Long 
Queries) 
В целом, Tableau постарается избежать длительных 
запросов и только получит область для фильтра. 
Однако, когда запрос выполняется, теперь у вас есть 
возможность пропустить начальный запрос. Когда вы 
пропускаете запроса Фильтр открывается с 
использованием типа режима ввода значений, который 
позволит вам самостоятельно ввести или вставить в 
список значений для фильтрации. 

 

Введите значения в Список Быстрого 
фильтра (Quick Filter) 
Существует новый тип быстрого фильтра, 
называемый «Список для ввода» (Type In List). 
Этот тип быстрого фильтра очень похож на тип 
списка в диалоговом окне фильтра. 

 
Поиск значений 
Используйте новое окно поиска, чтобы найти и выбрать значения, которые нужно фильтровать. Если запрос 
уже получил всю область значений, поиск будет показывать результаты в режиме реального времени, что вы 
могли выбрать необходимые значения до окончания полного точного значения. Если область значений 
неизвестна, нажмите кнопку Поиск на верхней правой части окна поиска. Этот поиск требует другого запроса, 
который может занять некоторое время. 

  
  

Если список пуст, то фильтр будет 

использовать по умолчанию "Все 

значения" (Use All) . Вы можете 

настроить поведение по умолчанию, 

используя меню на панели быстрого 

фильтра. 

Когда область значений 

известна, результаты поиска 

показывает значения в 

реальном времени. 

Если область значений 

неизвестна, нажмите кнопку 

Поиск для создания запроса. Или 

нажмите кнопку Плюс, чтобы 

добавить определенное 

значение в список фильтров. 
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Вычисляемые Итоги (Computing Totals) 

Tableau теперь поддерживает функцию Общие итоги и Промежуточные итоги для реляционных и многомерных 

источников данных. Следуйте инструкциям ниже, чтобы узнать, как использовать эти две особенности. 

Общие Итоги 
Включите Общие Итоги для столбцов или для 
строк 
Выберите меню, чтобы отобразить Итоги  для 
столбцов: Table > Grand Totals for Columns: 

 
 
Для строк выберите меню: Table > Grand Totals for 
Rows 

 

Промежуточный итог 
Включите промежуточные итоги для 
определенного Поля 
Зайдите в раскрывающееся меню поля (Field Menu) и 
выберите «Промежуточные Итоги» (Subtotals) 

 
Для добавления промежуточных итогов по всем 
полям, выберите опцию добавить Все 
Промежуточные итоги» в меню Таблицы «Table > Add 
All Subtotals» 

 
 

Итоги в многомерных источниках данных 
Когда вы включаете общие итоги или промежуточные 
итоги, используя вышеуказанные рекомендации, 
вычисление по умолчанию происходит на сервере. Если вы 
используете многомерный Источник данных, иногда 
бывает невозможно провести расчет на сервере, чтобы 
вычислить итоги точно. В этом случае вы можете указать, 
чтобы сделать вычисления локально, используя данные, 
которые вы видеть в таблице. Следуйте этим инструкциям 
для Переключения на локальные вычисления. 
 
 

Переключится на локальные вычисления 
Щелкните правой кнопкой мыши на меру, для 
которой включен расчет итогов. Затем 
выберите тип агрегации из подменю. 
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Создание вычисляемых полеи  - Кубы 

Tableau теперь поддерживает вычисляемые поля из многомерных источников данных. Есть два вида 

вычисляемых полей: вычисляемые меры и расчетные измерения. Вы можете создавать вычисляемые поля, 

используя либо  формулы Tableau, которые более простые в использовании, или MDX формулы, которые 

являются более сложными и требуют дополнительной подготовки. Следуйте инструкциям ниже, чтобы узнать, 

как создать новое вычисляемое поле.  

Определение вычисляемых полей 

При определении нового вычисляемого поля, вы создаете новое поле в источнике данных на основе 

существующих мер в источнике данных, а также стандартных функций и операторов. Следуйте шагам, 

описанным ниже, чтобы научиться создавать вычисляемое поле с применением формул Tableau. Более 

сложные запросы MDX описаны на следующей странице.  

1. Откройте окно редактора расчетных 
полей 

Щелкните правой кнопкой мыши в области окна 
данных и выберите "Новое вычисляемое поле" 
(New Calculated Field). 

 

2. Определите формулу 
В Редакторе Расчетных Полей, укажите имя новому полю 
и определите формулу его расчета. После завершения, 
нажмите кнопку "Проверить формулу" (Check Formula) 
для проверки синтаксического написания. 

 
Выбирайте доступные поля и формулы двойным 
щелчком мыши, что бы добавить их к формуле. 

3. Использование нового поля 
Когда ваша формула верна, нажмите «ОК», чтобы 
сохранить новое поле. Новое поле появится в 
области мер. 

 

4. Изменить формулу. 
Если вам необходимо изменить формулу вычисляемого 
поля, просто щелкните правой кнопкой мыши на этом 
поле в области данных и выберите "Изменить" (Edit). 
Имейте в виду, что изменения будут влиять на все листы, 
в которых используется это поле. 
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Расчеты Таблиц 

Функция Расчета в Таблице применяются к значениям во всей таблице и часто зависят от структуры самой 
таблицы. Например, в среде продаж, вы можете использовать таблицу расчетов для вычисления 
промежуточных итогов продаж через указанный диапазон дат или вычислить вклад каждого продукта в общий 
объем продаж за квартал. 

1. Откройте диалоговое окно Расчет 
Таблицы. 

Щелкните правой кнопкой мыши на мер, 
которую вы хотите использовать в расчетах и 
выберите "Добавить Расчет таблицы" (Add Table 
Calculation). 

 

2. Выберите тип вычислений 
В диалоговом окне Расчет таблицы выберите тип расчета, 
который вы хотите использовать. 
 
• Difference From: Показывает абсолютное изменение. 
• Percent Difference From: Показывает процент 
изменения. 
• Percent From: Показывает, долю % от другого 
указанного 
значения. 
• Percent From 
Total: Показывает 
значение в % от 
общего итога. 
• Running Total: Показывает нарастающий итог. 
• Moving Calculation: - Расчет скользящей для 
долгосрочных тенденций. 

3. Определите Расчет. 
В нижней части диалогового окна Расчет 
Таблиц, Выберите метод расчета из 
раскрывающегося списка. Определенный вами 
расчет можно прочитать как завершенное 
выражение. 

 
Определение параметров меняться в 
зависимости от типа расчета, который вы 
выбрали. 

4. Проверьте результат расчета. 
Когда вы закончите определение расчета, нажмите кнопку 
ОК. Мера должна превратиться в новое поле и будет 
отмечено знаком "Дельта" 

 
Вы можете редактировать Расчет Таблицы, выбрав из 
всплывающего меню поля «Edit Table Calculation» 
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Используйте быстрый Расчет Таблиц (Table Calculations) 
Tableau предлагает основные виды расчета таблиц, которые можно 
применить на вашем Представлении (View) быстро, без определения 
сложных формул расчета. Вам доступны следующие виды расчета: 
 
Running Total - Накопительный итог 
Difference - Отношение  
Percent of Difference - Различие в процентах 
Percent of Total - Доля от суммы 
Moving Average - Скользящая средняя 
Year to Date Total* - Итого с начала года* 
Compound Growth Rate* - Комбинированный темп роста* 
Year over Year Growth* - Сравнение с предыдущим годом* 
Year to Date Growth* - С начала года* 
*Эти вычисления основаны на поле даты и доступны, только если у вас 
есть поле формата даты в представлении. 

 Добавьте Быстрый расчет 
таблицы. (Quick Table 
Calculation) 

Щелкните правой кнопкой мыши 
на меру, которую Вы хотите 

использование в расчетах и 
выберите "Quick Table 
Calculation". 
 

 

Скрытие столбцов и строк (Hide Columns 
and Rows) 

Иногда вам может потребоваться включить значений в расчеты и итоговые величины, но не показывать их в 

представлении. Например, в Представлении квартального роста может понадобиться скрыть первый квартал 

из набора, поскольку его не с чем сравнивать. 

1. Щелкните правой кнопкой мыши на 
столбец или строку 

Щелкните правой кнопкой мыши столбец или строку, 
которую нужно скрыть. Затем выберите "Скрыть" 
(Hide). 

 
Столбец скрыт, но его данные по-прежнему 
учитываются во всех расчетах. 

2. Показать скрытые столбцы и строки 
Откройте раскрывающееся меню поля, которое имеет 
скрытые столбцы или строки, и выберите 
«Показывать скрытые данные» (Show Hidden Data). 
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Пример: Анализ прироста квартала к кварталу 
Представление внизу показывает прирост квартала к кварталу, это рассчитано с помощью функции расчета 
таблицы - процентной разницы. Вы видите, что колонка Q1 за 2008 пустая, поскольку ей не с чем 
сравниваться. В этом случае вы можете щелкнуть правой кнопкой мыши на столбец и выбрать "Скрыть" 
(Hide), чтобы удалить его из вида, но продолжать использовать его в таблице для расчета Q2. 
 

 
 
 

 

Параметры (Parameters) 

Параметры представляют собой динамические значения, которыми можно заменять постоянные значения в 

вычислениях. Например, можно создать вычисляемое поле, которое возвращает истину, если продажи 

превышают $ 500 тысяч, а в противном случае возвращает ложь. Вы можете заменить постоянное значение 

"500000" в формулу с параметром, которую можно будет менять динамически в окне управления параметром. 

1. Создать параметр 
Вы можете создать параметры непосредственно в 
меню редактирования вычисляемых полей. Щелкните 
на ссылку «Создать» (Create) в верхней части списка 
параметров. 

 
 

2. Определение Параметра 
Укажите следующие свойства для определения 
параметра: 
Имя (Name) - Название вашего параметра. 
Тип данных (Data type) - Параметры могут иметь 
целые числа, числа с плавающей точкой, строчные 
значения, логические значения, даты, даты и время. 
Current Value - Значение по умолчанию. 
Display format  - Формат отображения на экране. 
Допустимые значения (Allowable Values) - Этот тип 
используется для выбора допустимых значений. 
Параметры могут быть определены как "Открытые" 
(использующие все значения), тук и список или 
диапазон заданных значений. 
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Вы также можете щелкнуть 
правой кнопкой мыши в 
окне данных и выбрать 
пункт «Создать параметр» 
(Create Parameter) 

 

3. Использование параметров в расчетах 
Замените постоянное значение в вычисляемом поле 
на параметр. Вы можете дважды щелкнуть на 
параметр в списке, чтобы добавить его в формулу. 

 

4. Показать Панель Управления 
Параметра 

Параметры являются глобальными переменными 
для всей книги и показаны в нижней части окна 
данных. Щелкните правой кнопкой мыши на 
параметре и выберите «Показать Панель 
Управления» (Show Parameter Control), чтобы 
открыть окно, где вы можете изменить значение 
параметра. 

 
 

 

Форматирование (Formatting) 

Используйте функционал форматирования, чтобы изменить текст, заливку, границы, формат чисел и многое 

другое. Укажите параметры формата для всего листа, всех строк, всех столбцов, или формат отдельных 

элементов Представления, например, конкретного Поля (Field) или Относительной Линии. (Reference Line) 

1. Открытый окно Формат (Open the 
Format Window) 

Выберите опцию форматирование в меню 
Формат (Format). Меню Формат откроется с левой 
стороны экрана. 

2. Изменить параметры формата (Format 
Settings). 

Используйте раскрывающиеся списки в окне Формат 
(Format), что бы изменять представления  
форматирование. 
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Просматривайте изменения, чтобы подобрать 
необходимый вид. 

3. Формат листа (Worksheet Format) 
Используйте панель инструментов в верхней 
части окна Формат (Format), чтобы выбрать 
необходимые элементы листа, которые вы хотите 
отформатировать. 

 
Используя  вкладки в верхней части окна Формат 
(Format) для указания параметров 
форматирования для всего листа, всех строки 
или всех столбцов. 

 

4. Форматирование отдельных Полей (Fields) 
в Представлении (View) 

Иногда потребуется задать формат конкретной области 
или объекту, не затрагивая все остальное. Щелкните 
правой кнопкой мыши на Поле или Объект и выберите 
Формат (Format). 

 
 

Очистить форматирование (Clear Formatting)  
Используйте команду «Очистить Форматирование», расположенную на панели 

инструментов.  

Жирный метки в окне Формат (Format) указывают на параметры, которые были изменены. 

Вы можете очистить эти настройки индивидуально, щелкнув правой кнопкой мыши и 

выбрав опцию «Очистить» (Clear).  

Аннотации (Annotations) 

Используйте функцию «Аннотации», чтобы привлечь внимание к конкретным точкам, меткам, и областям на 

вашем Представлении. Вы также можете добавить комментарий к вашей  информации, которая сделает ваше 

представление более понятным. Аннотации могут быть изменены, перемещены, и отформатированы. 

1. Добавить комментарий (Add Annotation) 
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В раскрывающемся меню выберите, «Комментировать» (Annotation) и выберите тип аннотации, который вы 
хотите добавить. Щелкните правой кнопкой мыши на метку, точку или область, которую вы хотите 
прокомментировать. 

  
2. Изменение Размера (Resize) и 

Перемещение (Reposition) 
Нажмите и перетащите Комментарий (Annotation) 
к новому местоположению. 

 
Используйте маркеры изменения размера, чтобы 
изменить размер области Комментария. 

 

3. Формат Аннотации 
Щелкните правой кнопкой мыши и выберите «Формат» 
(Format) Аннотации. В окне Форматирования, вы 
можете изменить текст,  форму и параметры линии. 

 
Удерживайте клавишу (Ctrl) на клавиатуре, чтобы 
выбрать несколько Комментариев и применить 
параметры форматирования ко всем сразу. 

 

Удалить Аннотацию (Remove Annotations) 

Напишите текст 

комментария  в 

следующем окне  и 

нажмите кнопку ОК. 
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Выберите Аннотацию, которую вы  хотите удалить, щелкните правой кнопкой мыши и выберите «Удалить» 

(Remove). Вы можете выбрать несколько Аннотаций и удалить их все сразу с помощью клавиши «Ctrl» на 

клавиатуре.  
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Общая Кодировка (Shared Encoding) 

Когда вы используете одно и тоже поле для выделения цветом и тот же формат кодирования, то, используя 

эту функцию,  в нескольких листах рабочей книги, они будут автоматически использовать те же цвета и вид. 

Ваш документ будет более согласован и полн взаимосвязанных Представлений (View). 

Например, если мы рассматриваем данные о студентах, которые вероятно имеют  поле "Пол". При 

размещении этого поля на панель «Цвет» (Color), цвет будет использован по умолчанию. 

 

Вы можете редактировать цветовую кодировку, дважды щелкнув на легенде или нажав правой кнопкой 

мыши на поле в окне данных (Data window), и выбрав «Редактировать кодировку» (Edit Encodings). 

Так или иначе, что если вы зададите розовый цвет для «Женщин» и синий для «Мужчин», Вы задаете это 

однократно и каждый раз при использовании этого поля вы увидите только те цвета, которые вы указали. 

 

Формат световой кодировки применяется для нескольких листов во всем документе. 
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Разметка Областеи  Дашборда 

Функция разметки областей поможет вам организовать листы и другие объектов на Дашборде. При разметке, 

создается отдельная область на Дашборде, которая может автоматически регулироваться по размеру и 

размещению относительно других объектов Дашборда. Например, когда у вас имеется Дашборд с функцией 

Дрилл-даун, вы можете настроить автоматическое масштабирование области детальных данных в соответствии 

с выборкой. 

1. Добавьте Разметку Области (Layout 
Container) 

Создайте новый Дашборд и перетащите 
горизонтальную (Horizontal) или вертикальную 
(Vertical) область разметки на Дашборд. 

 

2. Добавить Листы и Объекты  
Перетащите листы в Размеченную Область. Если навести 
указатель на размеченную область, то стрелка покажет, 
как объекты будут в ней размещены. 

 
Быстрые фильтры и легенда добавляются автоматически 
для каждого Листа. добавляются с каждого листа. 

3. Понаблюдайте, как объекты 
перемещаются и изменяют свой 
размер 

Ниже, на Дашборде показано, как применяется 
фильтр, то таблица становится который короче. 
Потому что оба Представления расположены 
вертикально, и карта автоматически изменяет 
размер в соответствии выборке. 

 

4. Удалить Разметку Области (Layout 
Container) 

Вы можете удалить Разметку, открыв раскрывающееся 
меню одной из размеченных областей вашего 
Представления. Затем выберите опцию "Выбрать 
Область Разметки" (Select Layout Container). Теперь 
откройте меню, выбранной области разметки и 
выберите "Удалить" (Remove from Dashboard). Все 
размещенные ранее элементы, в размеченной области, 
будут удалены с Дашборда. 

 

Область Разметки имеет 

оранжевую рамку 
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Форматирование текста (Rich Text 
Formatting) 

Формат Заголовков, подписи, подсказки, Быстрые фильтры, Заголовки легенды, аннотации и текст областей 

Дашборда используют объект Rich Text. Это означает, что вы можете изменить шрифт и стиль для всего или 

части, введённого текста. 

1. Формат Названий и подписи 
Дважды щелкните на заголовке или подписи для 
форматирования текста. 
 

 
 
Нажмите кнопку "Очистить форматирование" (Clear 
Formatting) в правом верхнем углу диалогового окна 
"Изменение", чтобы вернуться к форматирование по 
умолчанию. 

2. Редактируйте формат всплывающих 
подсказок 

Выберите меню Edit > Tooltip для изменения 
содержания всплывающей подсказки. В дополнение к 
форматирование текста, вы также можете добавлять и 
удалять, отображаемую информацию. 
 

 
 
Используйте меню «Вставка» (Insert)  в верхней части 
диалогового окна, для добавления динамического 
текст на всплывающую подсказку. Например, вы 
можете добавить значения на основе полей, 
используемые в Представлении. 

3. Формат Быстрого фильтра и Заголовков 
легенды (Quick Filter, Legend Titles) 

Откройте Быстрый фильтр или меню легенды и 
выберите пункт «Изменить Название» (Edit Title) 
 

 
 
Расширенное форматирование текста отображается, 
только если быстрый Фильтр и Панель легенды 
включена на Дашборде. 

4. Формат Аннотации и Текстовые области 
Дважды щелкните на аннотации или текстовой 
области Дашборда для форматирования текста. 
 

 
 
Отформатируйте аннотацию отдельно (например, 
включите заливку, стрелки, и т.д.), выбрав меню 
Format > Annotations. 
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Улучшения в Карточках (Cards) 

Каждый лист содержит различные Карточки, которые можно отобразить или скрыть. Карточки представляют 

собой небольшие панели управления, например, для легенды и другие. Например, Карточка "Marks" содержит 

перечень значков для отметки выбранных данных, текстовые параметры, управление цветом, и так далее. В 

версии 6.0 Есть несколько обновлений для этих карт, которые помогут вам манипулировать страницами 

данных, параметрировать свойства формата метки, и взаимодействовать с Дашбордом. 

Метки Подписей и Текста (Labels, Text) 
Откройте раскрывающееся меню «Text» 
расположенное справа от названия на панели 
«Marks». Вы можете задать свойства шрифта, 
выравнивание и то какие метки стоит отображать. 

 

Маркировка Цветом (Colors) 
Откройте раскрывающееся меню рядом с полем 
(Colors) на карточке (Marks), чтобы сделать значки 
более прозрачными. Вы также можете указать 
эффекты, такие как метки с линиями, показывать ли 
границы меток или рамку вокруг каждой метки. 

 

История Страниц (Page History) 
Это меню содержит новую возможность - "Показать Историю" (Show History). Когда эта опция включена, то 
следы предыдущей страницы показаны на экране. Вы можете использовать раскрывающееся меню 
«Показать историю», чтобы определит формат отображения исторических данных. Вы можете показать 
историю для всех меток, только для выделенных значений или конкретных значений. 

 
 

Выбранные знаки на этом 

представления показывают 

значения для 2008 года, а 

также 2007. 
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Настраиваемые Представления (Custom 
Views) 

Вероятнее всего вы столкнётесь с необходимостью устанавливать одни и те же настройки для каждого 

представления. (например, выбор фильтров данных за которые несете ответственность только вы). Вместо того, 

чтобы каждый раз устанавливать одну и туже выборку, вы можете воспользоваться функцией запомнить 

пользовательские изменения в Представлении. 

Переход к ранее сохраненным настройкам (Remembering Changes) 

Откройте Представление и внесите некоторые изменения, которые вы хотите сохранить. Например, измените 

фильтры, сортировку или уровень масштабирования и т.п. Затем выберите «Сохранить» (Save) в правом 

верхнем в меню «Remember my changes» 

 
Настраиваемые Представления относятся к первоначально созданному документу, и не храняться отдельно на 

сервере. Это означает, что если оригинальное Представление изменится или обновиться, то ваши настройки 

тоже поменяются. Кроме того, если первоначальное Представление будет удалено с сервера, 

пользовательский настройки будут тоже удалены. 

Совместное использование ваших настроек (Sharing Your Changes) 

Вы можете поделиться своим настройками с другими людьми, чтобы они могли быстро посмотреть, то, что вы 

отфильтровали. Откройте одно из ваших Представлений и выберите опцию "Share" в правом верхнем углу 

экрана. 

  

  

 

Вы можете снять флажок на Представлении, чтобы сделать его 

приватным. Вы всегда можете вернуться к первоначальному виду 

Представления, выбрав Оригинальный вид (Original View).  

Теперь каждый раз, 

когда вы открываете это 

представление, оно 

будет подстраиваться 

автоматически под 

ваши настройки. 

 

В момент обзора Представления на сервере, вы 

можете просматривать сохраненные выборки 

Представлений других людей. Щелкните на Имя 

человека, что бы открыть его выборку.  
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Пакетные Книги (Packaged Workbooks) 

Достаточно часто книги имеют внешние ссылки на файлы и данные, которые хранятся на вашем локальном 

компьютере. Например, при подключении к файлам на основе источников данных Excel, Access, файлы данных 

Tableau,  текстовые файлы или использованные фоновые изображения. Благодаря Пакетным файлам вы 

можете сохранить ваши книги вместе с копией этих локальных элементов в единый пакетный файл. Одним 

файлом быстрее удобнее отправить вашу работу другим людям. 

1. Сохранить ваш документ как Пакетный 
Файл (Packaged Workbook)  

Выберите меню File > Save As. В следующем 
диалоговом окне, выберите тип файла "Packaged 
Workbook". 
 

 
Пакетный тип файла имеет расширение .twbx 

2. Поделитесь своей работой с другими 
людьми 

Книга упакована в один файл, этот файл содержит 
копии локальных файлов, чтобы вы могли легко 
отправить его по электронной почте, выложить в 
общую папку, либо опубликовать на сервере 
Tableau. 
 

 
 

3. Открытие Пакетных Файлов 
Вы можете легко открыть упакованный файл с 
помощью Tableau версии 3.5 и выше. Просто дважды 
щелкните на файле, или перетащите файл на открытое 
приложение. 
 

 

4. Распаковка Пакетного Файла 
Вы можете получить доступ к упакованным файлам 
в любое время, путем разархивирования файла. 
Просто щелкните правой кнопкой мыши на 
упакованном файле книги на своем компьютере, и 
выбрать меню распаковать (Unpackage). 
 

 
 

 

 

  

Все файлы 

собираются 

в единый 

файл, 

который 

легко 

отправить 

другим. 

Распаковка 

создаст файл 

рабочей книги 

Tableau и папку со 

всеми файлами, на 

которые ссылается 

рабочая книга. 
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Настрои ка Быстрых Фильтров (Customize 
Quick Filters) 

При подготовке книги для других людей, вы можете настроить, какие опции быстрых фильтров будут 

показаны и доступны для всех. Например, вы захотите спрятать "(Все)" значения это опция доступна в 

многострочном списке значений. В дополнение ко всем опциям вы можете скрыть или показать окно 

поиска, окно включения / исключения, окно выбора типа фильтра, опцию включения дополнительных 

кнопок и многое другое. Настройка быстрых фильтров особенно полезна, если вы хотите отправить 

ваш файл коллегам, которые не имеют полной версии Tableau или работают на сервере. 

Откройте меню Быстрого фильтра и выберите пункт "Настроить" (Customize) 

Открытое меню быстрого фильтра (стрелка в верхнем правом углу на карточке управления быстрого фильтра). 

Затем выберите опцию "Настроить" (Customize) в подменю. Далее описаны различные варианты настроек: 

Show “All” Value 

 
Показать «Все» значения  

 

Show Search Button 

 
Показать кнопку поиска 

Show More / Fewer Button 

 
Показывать несколько значений в 

списке 

Show Readouts 

 
Показать «Вводимые» значения 

Show Slider 

 
Показать «Слайдер» 

Show Null Controls 

 
Показать меню управления 

пустыми значениями 

Show Include / Exclude 

 
Показать опции включения \ 

исключения значений 

Show Filter Types 

 
Показать типы фильтров 
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Совместное использование Представлении  
на сервере 

Легко поделиться своими Представлениями, использую сервер Tableau и опцию "Поделиться" (Share). Нажав 

на кнопку "Share" и сервер сгенерирует простую ссылку, которую  вы можете вставлять в другие объекты или 

веб-страницы (например, корпоративный блок или портал) или просто отправить по электронной почте 

коллегам. 

1. Откройте параметры предоставления 
общего доступа (Share) 

Нажмите кнопку "Share" в верхнем левом углу 
Представления на сервере. 

 
Ссылка «Share» может отображаться внизу, если 
зашли на встроенное Представление на другую 
вэб-страницу или вошли как «Гость» 

2. Отправьте по почте ссылку 
Скопируйте URL адрес ссылки из первого текстового 
поля, вставьте его в электронное письмо и отправьте 
коллегам. 

 

3. Добавьте встроенное Представление 
Скопируйте HTML-код из второго текстового поля 
и вставьте его в свой блог или веб-страницу на 
корпоративном портале. Интерактивное 
Представление будет показано внутри вашей 
страницы как ее часть. 

 

4. При желании, настройте параметры 
отображения 

Нажмите на ссылку Показать параметры в правом 
верхнем углу окна "Share", чтобы настроить вид 
отображения. Например, вы можете изменить ширину, 
высоты, и показывать панель инструментов. 
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